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Copyright © 1996-2014 Delcam Ltd. All rights reserved. 

Delcam Ltd has no control over the use made of the software 
described in this manual and cannot accept responsibility for any 
loss or damage howsoever caused as a result of using the software. 
Users are advised that all the results from the software should be 
checked by a competent person, in accordance with good quality 
control procedures. 

The functionality and user interface in this manual is subject to 
change without notice in future revisions of the software.  

The software described in this manual is furnished under licence 
agreement and may be used or copied solely in accordance with the 
terms of such licence. 

Delcam Ltd grants permission for licensed users to print copies of 
this manual or portions of this manual for personal use only. 
Schools, colleges and universities that are licensed to use the 
software may make copies of this manual or portions of this manual 
for students currently registered for classes where the software is 
used. 
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Patents 

The technique of using a wall-mounted scanner to capture a 
photographic side profile of a human face, which is then used to 
create a 3D relief in ArtCAM, is subject to a patent. 

Patent No: GB 2 387 731 "Deriving a model from a scan of an 
object" 

The functionality of preparing a 3D relief of the side profile of a 
human face direct from a photograph in ArtCAM is subject to a 
patent. 

Patent No: GB 2 403 883 "Photo to 3D" 

The functionality of the 3D layers used to design and machine an 
article in ArtCAM is subject to a patent application. 

Patent No: GB 2 434 287 "3D Layers" 

The functionality of creating a low relief from an imported 3D object 
in ArtCAM without losing low-level detail is subject to a patent. 

Patent No: GB 2 455 966 "Method and System for Generating 
Low Reliefs – a.k.a. Scan to Low Relief" 

The functionality of filling an area with geometric or natural textures 
using pattern elements and a controlling direction line in ArtCAM is 
subject to a patent application. 

Patent Application: GB 2492225 "Texture Flow" 

The Support structure functionality is subject to patent applications. 

Patent application: US 14325878 Method for calculating support 
structures and support elements for attaching a support strut of 
same 

Patent application: GER 10 2013 011 630.9 Method for 
calculating support structures and support elements for attaching 
a support strut of same 
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The ArtCAM family is a range of unique and scalable artistic 
CADCAM software solutions used in a wide variety of industries 
worldwide. It provides the functionality to entirely design and RP, 
CNC or laser machine a number of 2D and 3D products. It is used to 
make signs, furniture, and sculptures as well as being a vital design 
and manufacturing resource in applications such as product design, 
packaging and engraving for the minting and print industries, 
amongst many others.  

The range includes: 

 ArtCAM Express — Entry level CADCAM software for hobbyists 
and small businesses. 

ArtCAM Express is an affordable entry level product that contains 
a variety of 2D design and 2D/3D machining features. A good 
starting point for any new router owner; you can also add more 
features to your software as you need them. 

 ArtCAM Insignia — Introductory 3D design and manufacturing. 

ArtCAM Insignia is the mid-range product in ArtCAM's artistic 
CADCAM software range. Extending the functionality of ArtCAM 
Express, ArtCAM Insignia features an expanded toolkit 
specifically for repeat designs in a production environment and 
introductory 3D design tools. 

 ArtCAM Pro — Advanced 2D and 3D design and manufacturing. 

Our professional software package gives you the power to design 
and manufacture premium quality 3D models or 3D sculpted 
reliefs quickly and easily. 

 ArtCAM JewelSmith — Professional jewellery design and 
manufacture. 

ArtCAM JewelSmith combines the 2D and 3D design and 
manufacturing capabilities of ArtCAM Pro with extensive jewellery 
specific tools and libraries to create highly custom personalised 
jewellery pieces through to new complete lines. 

Getting Started in ArtCAM 
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Finding out more about ArtCAM 
You can find information about the features in ArtCAM from the 
following sources: 

 Inline-help.  

Click  on a panel's header to toggle the display of its in-line 
help. 

 
 The ArtCAM Reference Help system.  

In the Main Menu bar, select Help > Contents. 

 
 The ArtCAM What's New system. 

In the Main Menu bar, select Help > What's New 

 
 The Live! panel. 

Move the cursor over the Live! tab in the right docking area: 

 
 The Tutorials panel. 
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Move the cursor over the Tutorials tab in the right docking area: 

 
 The Start panel.  

Click  in the Other Features area to display details of new 
features and enhancements. 

 The ArtCAM website.  

In the Main Menu bar, select Help > ArtCAM on The Web > ArtCAM 
Home Page. 

 The ArtCAM User Forum.  

In the Main Menu bar, select Help > ArtCAM on The Web > ArtCAM 
Forum. You can also access the forum at 
http://forum.artcam.com (http://forum.artcam.com). 

 If you have not yet registered as a forum member, click the 
Register option on the forum's home page to do so. 
Registered users are able to download images, example 
ArtCAM models and relief clipart files attached to posts. 

 Subscribe to the ArtCAM Newsletter.  

In the Main Menu bar, select Help > Subscribe to the ArtCAM 
Newsletter to send an e-mail requesting subscription to the 
quarterly newsletter. 

If you are working in ArtCAM Express, you can find out information 
about the available modules in the Modules panel. 

Move the cursor over the Modules tab in the right docking area: 

 
 

http://forum.artcam.com/
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Installing your ArtCAM licence 
In order to use ArtCAM, you must ensure that a valid licence is 
installed. This licence can be installed as one of three file types: a 
PAF file (dcam.paf), a Delcam Licence file (dcam.dcamlic), or an ELF 
file (dcam.elf). 
If you have installed ArtCAM from a disc and have a dongle, your 
licence should have been emailed to you. To install your licence: 

1 Plug the dongle into your computer. 

2 Start ArtCAM. A dialog is displayed asking if you want to install a 
new licence. 

3 Follow the on-screen instructions to display the Select Licence File 
To Install dialog: 

 
4 Navigate to the folder on your computer in which your licence file 

is stored. 

5 Select the licence file and click Open. The dialog closes and the 
licence is installed. 

If you have installed a pre-registered version of ArtCAM and do not 
have a dongle: 

1 Start ArtCAM. A start-up screen is displayed. 

2 Follow the on-screen instructions to activate your product and 
receive your licence. 
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Updating ArtCAM 
To check for software updates and patches from within ArtCAM: 

1 Ensure that you are connected to the internet. 

2 In the Main Menu bar, select Help > Check For ArtCAM Updates > 
Software Updates. 

If there are updates available, ArtCAM displays the Update 
settings on the Tool Settings tab, and opens a new browser 
window with the Delcam Customer Download Centre site 
displayed. 

3 In the navigation panel, select ArtCAM (see ) to display the 
latest downloads that are available to you: 

 
All of the available software updates and product updates are 
listed on this web page. In the File area, click a link to download 
its associated update or patch to your computer. 
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Files compatible with ArtCAM 
You can create a new model by opening a file saved in any of the 
following formats: 

 ArtCAM Model (*.art) 
 ArtCAM Relief (*.rlf) 
 Windows or OS/2 Bitmap (*.bmp) 

 Windows or OS/2 DIB (*.dib) 

 Windows or CompuServe RLE (*.rle) 
 JPEG Image - JFIF Compliant (*.jpg, *.jpeg, *.jpe and *.jfif) 
 CompuServe Graphics Interchange (*.gif) 
 Windows Enhanced Meta File (*.emf) 
 Windows Meta File (*.wmf) 
 Tagged Image File Format (*.tif and *.tiff) 
 Portable Network Graphics (*.png) 

 Windows Icon (*.ico) 

 Drawing Interchange Format, including PowerSHAPE and 
AutoCAD (*.dxf) 

 AutoCAD 2D Drawing (*.dwg) 

 Lotus, PC Paint or DUCT picture (*.pic) 
 Delcam DGK (*.dgk) 

 Portable Document Format (*.pdf) 
You can import vector artwork saved in any of the following formats 
into an open ArtCAM model: 

 Adobe Illustrator Image (*.ai) 
 Encapsulated PostScript (*.eps) 
 Drawing Interchange Format, including PowerSHAPE and 

AutoCAD (*.dxf) 
 AutoCAD 2D Drawing (*.dwg) 

 Lotus, PC Paint or DUCT picture (*.pic) 
 Delcam DGK (*.dgk) 

 Windows Meta File (*.wmf) 
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You can import triangle models saved in the following file formats 
into an open ArtCAM model: 
 3D Assembly (*.3da) 
 ArtCAM Project (*.3dp) 

 3D Studio (*.3ds) 
 Drawing Interchange File (*.dxf) 
 Binary or ASCII STL  (*.stl) 
 Universal 3D File (*.u3d) 

 Wavefront Object File (*.obj) 
 Delcam Machining Triangles (*.dmt) 
You can import surface models saved in the following file formats 
into an open ArtCAM model: 

 3D NURBS Modeller - Rhinoceros (*.3dm) 

 Delcam DGK (*.dgk) 

You must have Exchange 7.0.1005 or above installed on your 
computer to import all triangle and surface models. 

 If you are using ArtCAM Express, you can only import certain 
files when you have the File Import module. 
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The ArtCAM layout 
The ArtCAM layout depends on whether or not you have a model or 
project open.  

 If you are working in ArtCAM Express or ArtCAM Insignia, you 
cannot create or open a project. 

The starting layout 
When you start ArtCAM, the layout includes six key areas:  

 

  
Main Menu bar — Select a menu item associated with a 
particular part of the ArtCAM's design process to display a 
drop-down menu of sub-menus and commands. Most of these 
are inactive until you create a model or project. 

 Top docking area — The File toolbar is docked horizontally here. 
This enables you to create a new project or independent model, 
or open a previously saved project or independent model. You 
can also set your preferences and display the Reference Help. 
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 Start panel — This docked panel enables you to create a new 
model or project, or open a previously saved model or project. 
Your recent files are listed and can be reopened. You can also 
start the Font Editor and MillWizard standalone tools, or use the 
Face Wizard tool to create a new model from a photographic 
image containing a side profile of a person's head and neck. 
For more information, see The Start panel (see page 32). 

 When a model or project is created or opened, the Start 
panel is hidden. 

 If you are working in ArtCAM Express or ArtCAM Insignia, 
the Projects area and Face Wizard tool are not included.  

 Tutorials — This tab displays a panel that provides information 
on where to download tutorial packs. Any tutorial packs 
included in your installation are listed. 

 Live! — This tab displays a panel that provides online videos 
you can watch to learn about working in ArtCAM. 

 Toolbox — This tab displays a panel that contains compatible 
plug-in tools. Any plug-ins included in your installation are 
listed. 

 If you are working in ArtCAM Express, the Toolbox panel is 
replaced by the Modules panel, which provides information 
about the available modules and enables you to purchase 
them. 
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The open model layout 
When you create a new, independent model, the layout includes the 
following areas: 

 

  
Menu Bar — As described previously, although more sub-menus 
and commands are active. 

 Top docking area — Eight toolbars are docked horizontally here: 
File, Model, Bitmap Tools, Vector Creation, Relief Creation, Vector 
Editing, Relief Editing and Fill Tools. 
Up to four additional toolbars are hidden by default: Simulation, 
Rotary Relief Tools, Gem Tools and Back Relief Tools. When 
displayed, these are also docked. 

 If you are working in ArtCAM Express or ArtCAM Insignia, 
the Rotary Relief Tools, Gem Tools and Back Relief Tools 
toolbars are not available. If you are working in ArtCAM 
Pro, the Rotary Relief Tools and Gem Tools toolbars are not 
available.  

 Almost all of the toolbars' tools are also available from the 
Assistant panel, which is hidden by default to maximise the 
viewing area. When displayed, this panel is docked on the 
left.  

 Left docking area — The View Manipulation and Design Tools 
toolbars are docked vertically here. The former enables you to 
twiddle and zoom, while the latter contains four tool groups: 
modes, painting, drawing, and sculpting.   
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 Viewing area — The viewing area contains two types of tabbed 
windows: the 2D View and 3D View. These display the layers of 
two-dimensional vector and bitmap artwork in your model. The 
3D View window also displays the relief layers containing your 
three-dimensional shapes, calculated toolpaths, and toolpath 
simulations. Each window has a toolbar and colour palette. For 
more information, see The design windows. 

 Project panel — This docked panel displays the Project Tree and 
tools associated with its items. The Project Tree maps the 
different elements of your model. Its items provide context 
menus that enable you to create models, layers, triangle 
meshes, assemblies, and replica meshes, as well as calculate, 
edit, and simulate toolpaths. For more information, see Using 
the Project panel. 
Five panels are hidden by default: Toolpaths, Relief Layers, 
Bitmap Layers, Vector Layers and Assistant. When displayed, 
each panel is docked and pinned. The layers panels are also 
tabbed. 

 If you are working in ArtCAM Express or ArtCAM Insignia, 
the Relief Layers panel is not included. 

The open project layout 
When you create a new project, the layout includes four key areas: 

 

 If you are working in ArtCAM Express or ArtCAM Insignia, you 
cannot create a project. 
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Menu Bar — As described previously, although fewer sub-
menus and commands are active compared to when a model is 
opened. 

 Top docking area — The File toolbar is docked horizontally here. 

 Viewing area — The viewing area is filled by a tabbed 3D View 
window. This displays the assemblies and replica meshes 
included in your project. When a model is opened as part of 
your project, in the 3D View window, you can toggle between 
the display of your project's assemblies and replica meshes, as 
well as the model's relief layers, calculated toolpaths and 
toolpath simulations. 

 Project panel — The Project Tree displays only two items: one 
that enables you to import ArtCAM models, triangle models and 
surface models as assemblies and replica meshes, the other to 
create and import ArtCAM models. 

 
 

Docking areas 
There are four docking areas, one located on each side of the 
viewing area. 

The docking areas are highlighted in red: 
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When you start ArtCAM or create a project, the top docking area 
contains: 

 the Menu Bar, which is docked horizontally below the Title Bar. 

 
 the File toolbar, which is docked horizontally below the Menu Bar. 

 
When you create a model, the top docking area contains: 

 the Menu Bar, which is docked horizontally below the Title Bar. 
 the File, Model, Bitmap Tools, Vector Creation, Vector Editing, Fill 

Tools, View Manipulation, Relief Creation and Relief Editing 
toolbars, which are docked horizontally below the Menu Bar. 
File toolbar 

 
Model toolbar 

 
Bitmap Tools toolbar 

 
Vector Creation toolbar 

 
Vector Editing toolbar 

 
Fill Tools toolbar 

 
View Manipulation toolbar 
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Relief Creation toolbar 

 
Relief Editing toolbar 

 

 If you are working in ArtCAM Insignia, several tools are not 
included in these toolbars.  

Many toolbars include toolsets, which are identified by  in a 
button's bottom right corner. For example, the File toolbar includes 
the toolset shown below: 

 
A toolset's most recently selected button is displayed in the 
toolbar. The other buttons are hidden. 

If a complete toolbar cannot fit within a docking area: 

  is displayed at the end, when the toolbar is horizontal. 

  is displayed at the bottom, when the toolbar is vertical. 

Click this to display the toolbar's other buttons as a list of 
options. 

For example, when the Transfer tool is not displayed in the 
vertical Design Tools toolbar, it is included in the options list: 
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Docking areas, toolbars, and auto-hidden panels share a 
common context menu that you can use to control which 
toolbars and panels are displayed: 

 

 If you are working in ArtCAM Express or ArtCAM Insignia, 
the Rotary Relief Tools, Gem Tools, Back Relief Tools and 
Relief Layers options are not included. If you are working in 
ArtCAM Pro, the Rotary Relief Tools and Gem Tools option 
are not included. 

Pinned toolbars and panels are selected . The top half of the 
context menu comprises toolbar names, and the bottom half 
comprises panel names.  
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When you start ArtCAM or create a project, the right docking area 
contains: 

 the Toolbox, Tutorials and Live! panel tabs; 

   

 If you are working in ArtCAM Express, the Toolbox panel tab 
is replaced by the Modules panel tab. 

When you create a model, the left docking area contains: 

 the View Manipulation toolbar. 

 
 the Design Tools toolbar. 

 

 If you are working in ArtCAM Insignia or ArtCAM Express, 
there are fewer tools available from the Design Tools 
toolbar. For more information see the relevant topics in the 
reference help. 

When you create a model, the right docking area contains the 
Toolbox, Tutorials and Live! panel tabs, which are vertical: 

   

 If you are working in ArtCAM Express, the Toolbox panel tab 
is replaced by the Modules panel tab. 

 

Viewing area 
When you start ArtCAM, the viewing area is empty.  

When you create a model, the viewing area contains the 2D View 
and 3D View windows, tabbed with the 2D View window active. 
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The following image shows the ArtCAM layout when a new model is 
created. The viewing area is highlighted in red: 

 
When you create a project, the viewing area contains the 3D View 
window, tabbed and active. 
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Status bar 
From left to right, the following information is displayed along the 
Status Bar: 
 a tool description, when the mouse cursor is over a toolbar 

button or menu. For example, when the cursor is over the New 

Model  button, Create a new model is displayed on the 
bottom left: 

 
 a progress bar, when toolpaths and three-dimensional shapes 

are being calculated. 

 
 the cursor's XYZ coordinates, when the cursor is over the View 

window. 

 
 the height and width of the bounding box, when vector artwork 

or toolpath previews are selected. 

 
 a resizing grip. 
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Extending ArtCAM Express 
The Modules panel provides brief information about the modules 
compatible with ArtCAM Express, and enables you to purchase 
them. Modules offer a more versatile way of working, and increase 
your choice of machining methods. 

On starting ArtCAM Express, and when no model is open, the 
Modules panel is docked and pinned on the right.  

When you create or open a model, the Modules panel is auto-
hidden. The space previously occupied by the Modules panel is then 
used by the viewing area. 

Use one of the following methods to display the Modules panel: 

 Move the mouse cursor over the Modules tab in the docking area 
to the right of the viewing area: 

 
 Right-click a docking area, and then click to select Modules in the 

context menu. 

 In the Main Menu bar, select Window > Toolbars and Docking 
Windows > Modules. 

 In the Main Menu bar, select Help > Modules. 

 In the Start panel, click Modules in the Upgrades area. 

 By default, the Start panel is displayed only when no model 
is open. 

The Modules panel includes a: 

 list of modules already installed. 

 list of modules available to purchase. 

 shopping basket to purchase modules (see page 21). 

 tools to activate purchased modules (see page 30). 

The available modules are: 

 Advanced 2D Machining — This module enables you to apply 
several machining enhancements to new or previously calculated 
toolpaths that include one or more profile passes. These 
enhancements help deliver a better finish in your machined 
pieces, and reduce wear on your cutting tools.  
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 Nesting — This module enables you to fit vector text and shapes 
within a defined area; helping you to make economical use of 
your material, and to increase the efficiency of the toolpaths 
used to machine your pieces.  

 The Nesting module includes all of the functionality 
associated with the Advanced 2D Machining module. If you 
have the Nesting module installed, the Advanced 2D 
Machining module is moved from your list of available 
modules to your list of installed modules. 

 Vector Tools — This module enables you to work with several 
different pieces of vector artwork in a single ArtCAM model. It 
also provides further flexibility when editing vector artwork, and 
in converting vector artwork to bitmap artwork. 

 Bitmap Layers — This module enables you to work with several 
different images in a single ArtCAM model. These can be 
converted into vector artwork, or used to shade all or part of the 
relief. 

 Smart Engraving — This module enables you to create a toolpath 
that engraves within or around the boundary of vector text or a 
selection of vectors. 

 Raised Round — This module enables you to create a toolpath 
that produces precise recessed letters and shapes using vector 
text or a selection of vectors. 

 Feature Machining — This module enables you to create a 
toolpath that machines raised, recessed or centreline-engraved 
features created from vector artwork. 

 File Import — This module enables you to import a greater variety 
of 3D surface model files. These can be imported into an ArtCAM 
model and combined with your relief. 

 Texture Toolpath — This module enables you to create a toolpath 
that machines a texture across the whole surface, or a specific 
area, of your ArtCAM model using only a tool's geometry and 
machining parameters. 

 Font Creator — This module enables you to create your own 
fonts, or modify the collection of fonts already installed on your 
computer. 

 Fluting — This module enables you to create and control ramping 
cuts along vectors. The fluting toolpath is ideal for creating 
designs on wooden doors, or woven patterns around coins. 

 Bevel Carving — This module enables you to create a toolpath 
that replicates a bevelled (angled-edge) look for the vector 
artwork that you have selected. 
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 Multi-Plate Engraving — This module enables you to create sheets 
of badges or name-plates, each with its own unique details, 
using only vector artwork to control the shape and layout, a text 
file (*.txt or *.csv) containing the data you want to feature on the 
plates, and vector text to set how and where this data is used. 

 Toolpath Panelling — This module enables you to machine a 
design larger than the bed-size of your router, or larger than the 
sheets of material that are currently available. 

 

Purchasing modules 
 ArtCAM Express only. 

To purchase one or more modules: 

1 Display the Modules panel (see page 19). 

If you already have one or more modules installed, these are 
listed in the Installed Modules area. If you have no modules 
installed, the Installed Modules area is not shown. 

2 In the Available Modules area, click the name of the module that 
you want to buy.  

For example, Nesting:  

 
A brief description of the module is displayed, along with: 

 an Add button. This adds the module to your shopping basket. 

 a Learn More link. This opens a new browser window 
containing information about the module. 

 a Documentation link. This opens a help file containing 
information about the module, and how it is used. 

3 Use one of the following methods to add a module to your 
shopping basket: 

 Click Add. 

 Double-click the grey area containing the module's name. For 
example, Nesting: 
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When the first module is added to your shopping basket: 

 its module area is shaded green. 

 the Remove button replaces the Add button. 

 the shopping basket icon changes from  to .  

 the shopping basket status changes from Basket is empty to 
Selected Modules: 1. 

For each additional module that you add to the shopping basket: 

 its module area is shaded green. 

 the Selected Modules count increases by one. For example, 
with the Nesting and Vector Tools modules in the shopping 
basket, Selected Modules: 2 is displayed. 

4 Use one of the following methods to remove a module from your 
shopping basket: 

 Click Remove. 

 Double-click the green area containing the module's name. 
For example, Nesting: 

 
For each module that you remove from the shopping basket:  

 its module area is shaded grey. 

 the Selected Modules count decreases by one.  

When all modules have been removed from your shopping 
basket, Basket is empty is displayed. 

5 Ensure that only the modules that you want to purchase are 
included in your shopping basket, and then click Buy Online. The 
ArtCAM Online Store website is opened in a new browser window.  
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If you are not registered as a Delcam customer, the Country 
Selection page is displayed: 

 
a Click the Country list, and then select the country that 

corresponds to your billing address. For example, United 
Kingdom. This ensures that your items are priced in the 
correct currency. 

b Click Next. The Product Selection page is displayed.  
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If you are a registered Delcam customer, the Product Selection 
page is displayed: 

 
The Use Existing Dongle (Upgrade Existing Seats) option is 
selected. For each of the modules already included in your 
shopping basket: 

 its name is shaded in green. For example, Nesting. 

 
 its price is displayed.  

 the Remove option is displayed. 

The cost of your selected modules, before any applicable taxes, 
is also shown. 

6 Click: 

  to open a new window displaying information about the 
module. Click  to close the window. 
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 Add to add a module to your shopping basket. The Sub Total is 
updated, the module's name is shaded green, and Remove 
replaces Add. 

 If you have selected the Nesting module, the Advanced 
2D Machining module cannot be selected. The Nesting 
module includes all of the features in the Advanced 2D 
Machining module, and more. 

 Remove to remove a module from your shopping basket. The 
Sub Total is updated, the module's name is no longer shaded, 
and Add replaces Remove.  

 Empty Basket to empty your shopping basket. The Sub Total is 
reset. The Next button is greyed-out, and stays that way until 
at least one module is in your shopping basket. 

7 Click Next. The Personal Information page is displayed: 

 
8 To change the contents of your shopping basket, click Back and 

then repeat the last two steps. 
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9 In the Order Contacts area, select:  

 the contact entry including your correct name and email 
address. Your purchase invoice and updated PAF licence file 
are sent separately to this email address. 

 Create a new contact if your name and email address are 
incorrect. 

10 If you have selected Create a new contact, enter and review your 
contact information: 

a In the Full Name field, type your first name (given name) and 
second name (surname). 

b In the Email field, type your email address. Your purchase 
invoice and updated PAF licence file are sent separately to this 
email address. 

c In the Confirm Email Address field, type the same email 
address displayed in the Email field. 

11 Enter and review your billing information, including your EU VAT 
registration number (if applicable): 

a In the Company field, type your company name (if applicable). 

b In the Address Line 1 field, type your house number and street 
name, or your post office (P.O.) box number. 

c In the City field, type the name of the city that corresponds 
with your billing address. 

d Click the County / Province list, followed by your county, state 
or province. 

e In the Postcode / Zipcode field, type your postal or zip code. 

f In the Telephone Number field, type your preferred contact 
number. 

g If you are an EU VAT registered customer, type your ISO 
Country Code followed by your VAT number in the VAT Reg 
Number box. For example, GB 123456789. 
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12 Click Next. The Order Confirmation page is displayed: 

 
This shows: 

 your billing information. 

 the modules included in your shopping basket. 

 the price of each module in your shopping basket. 

 the combined cost of your chosen modules, before any 
applicable taxes. 

 the cost of all applicable taxes (for example, VAT if you are an 
EU customer). 

 the total cost. 

13 If there are any mistakes in your billing information, click Back 
and then repeat the last two steps. 
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14 Click Confirm Order. The Payment page is displayed: 

 
15 Click Make Payment. The payment provider page is displayed: 
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16 In the Card Details area, enter and review your payment card 
details. 

17 In the Cardholder Information area's Full Name field, type your 
name as it is displayed on your payment card.  

18 Review your cardholder information, and then click Submit 
Payment. The Payment Status page is displayed: 

 
19 Click: 

 Print to print a copy of your payment information. 
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 Complete Payment to complete payment and process your 
order. The Transaction Status page is displayed: 

 
 

Activating a module 
 ArtCAM Express only. 

When you have purchased a new ArtCAM Express module from the 
online store, you are:  

 sent an email confirming your purchase. 

 issued a new PAF licence file (*.paf) by email. 

Before you can use the module, you must activate it using your new 
PAF licence file.  

To activate a new module: 

1 Display the Modules panel (see page 19). 

2 In the Install licence from area, click:  

 Internet if you have an internet connection. A message dialog 
is displayed confirming that your licence file has been 
installed. Click OK to close the message dialog. 

 PAF File if you cannot connect to the Internet, but have the 
PAF file that was sent to the email address specified during 
your module purchase. The Select Licence File To Install dialog 
is displayed.  
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Select the PAF file (*.paf), and then click Open: 

 
A message dialog is displayed confirming that your licence file 
has been installed. Click OK to close the message dialog. 

3 Restart ArtCAM Express: 

a In the Main Menu bar, select File > Exit. 
b Click Start > All Programs > ArtCAM 2015 > ArtCAM 2015. 
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The Start panel 
When you open ArtCAM, and when no model or project is open, the 
Start panel is docked and pinned on the left. The panel is divided 
into four areas: Projects, Models, Recent Files and Other Features. 

 If you are working in ArtCAM Express or ArtCAM Insignia, the 
Projects area is not included.  

The Projects area enables you to: 

 create a new ArtCAM Project. 

 open an ArtCAM Project. 

The Models area enables you to: 

 create a new ArtCAM model of a specific size. 

 open a compatible file as an ArtCAM model. 

The Recent Files area enables you to open one of the last four 
ArtCAM Model files (*.art) or ArtCAM Project files (*.3dp) you have 
been working on. 

 If you are working in ArtCAM Express or ArtCAM Insignia, the 
last four ArtCAM Model files (*.art) are listed. 

The Other Features area enables you to: 

 create new fonts or modify them. 

 create a relief in the shape of a face from a photographic image. 

 If you are working in ArtCAM Express or ArtCAM Insignia, 
this option is not included. 

 open MillWizard. 

 find out about the latest features and enhancements (see page 
2). 

If you are working in ArtCAM Express, there is an Upgrades area 
which enables you to download new modules, or upgrade to ArtCAM 
Insignia or ArtCAM Pro. 

When you create or open a project or model, the Start panel is 
closed. The space previously occupied by the Start panel is then 
used by the viewing area. To display the Start panel again, right-
click anywhere on the top toolbar area and select Start. 
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Comparing bitmaps, vectors and reliefs 
Vectors and bitmaps are two different methods of reproducing 
particular types of images. ArtCAM uses both bitmap images and 
vectors to create three-dimensional shapes. In ArtCAM, a vector can 
be created from a bitmap image, and vice versa.  
Vector Data 

 

Bitmap Data 

 

The three-dimensional shapes created from the bitmap images and 
vectors in ArtCAM make up a relief layer. These relief layers make 
up the composite relief representing the piece that you want to 
machine.  

Vectors 

 
Vector data is defined mathematically. Objects are geometrical, 
being made up of a number of points connected by lines or curves. 
Vectors are extremely flexible and can be manipulated with both 
ease and accuracy. 

Vector data is ideal for producing smooth features. A vector not only 
has greater definition than the bitmap, the geometry of the vector 
can also be used to drive an assigned machining tool directly, 
which, in turn, can produce a better finish. 
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Vector artwork is drawn on vector layers in ArtCAM and can be used 
to create three-dimensional shapes on relief layers or toolpaths to 
machine a two-dimensional piece. 

Bitmaps 

 
Bitmap data is made up of a set of values specifying the colour of 
individual pixels (picture elements) that make up an image. Bitmap 
data is characterised by resolution and bit depth. 

Unlike vector data, bitmap data is large. For small compositions the 
increase in file size may not matter greatly, but for larger 
compositions the difference in file size seriously impacts machining 
times. 

ArtCAM allows three-dimensional shapes to be created from bitmap 
colours on bitmap layers. It can also read image files generated by 
other drawing and desktop publishing packages or those scanned 
from paper based artwork. 

Reliefs 

 

 If you are working in ArtCAM Express or ArtCAM Insignia, 
although there is a relief, there are no relief layers. 
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A relief is essentially one or more three-dimensional shapes created 
in ArtCAM. There are two different concepts to consider when 
working with reliefs: the relief layer and the composite relief.  

The content of a relief layer comprises one or more three-
dimensional shapes. The relief layers on which these different 
shapes are created make up the composite relief. The way each of 
the relief layers combine to form the composite relief depends on 
the combine mode assigned to each of them, and whether or not 
they are visible. 

The composite relief can be built from one of two layer stacks in the 
model; one representing the front surface of your design, the other 
representing the back. Although you can reassign a relief layer from 
one layer stack to the other at any time, you cannot view the 
composite relief resulting from both of these layer stacks 
concurrently. 

A compromise must be made between the quality of a model, 
including its associated relief layers, and the speed of the processor 
in your computer. For most jobs, a model of 1,000,000 points is a 
reasonable value. Since the content of a relief layer is made up of a 
number of points, even the quality and smoothness of the three-
dimensional shapes created from the artwork drawn across the 
vector layers depends upon the resolution of the model, although 
this is to a lesser extent than with those shapes created from 
colours on bitmap layers. 

 



 

36 • Getting Started in ArtCAM ArtCAM 2015 Getting Started  

Tutorial - Saw Mill sign 
This tutorial demonstrates how to create a Saw Mill sign from vector 
artwork. You will use ArtCAM's Vector Creation and Vector Editing 
tools to adapt the imported vector artwork, and then its Toolpath 
Operation tools to calculate the toolpaths needed to machine the 
sign. 

The stages covered by this tutorial are: 

 Preparing the model (see page 37). 

 Creating the offset vectors (see page 38). 

 Grouping the offset vectors (see page 40). 

 Creating additional vector text (see page 41). 

 Repositioning the vector text (see page 42). 

 Clearing the area around the text (see page 45). 

 Carving the text (see page 48). 

 Cutting out the sign (see page 49). 

 Saving the toolpaths (see page 55). 

At the end of this tutorial, you will have created all of the toolpath 
files needed to machine the Saw Mill sign using ArtCAM. 
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Preparing the model 
This section describes how to open the ArtCAM model containing the 
vector artwork needed to produce the Saw Mill sign. 

1 In the Start panel, click Open Model . The Open dialog is 
displayed. 

 
2 Navigate to the Examples folder on your computer.  

 If you did not install the Examples folder along with 
ArtCAM, you can find the folder on the ArtCAM installation 
DVD.  

3 To complete this tutorial using:  

 metric measurements, select the SawMill_Metric.art file. 

 imperial measurements, select the SawMill_Imperial.art file.  

 The .art suffix indicates that the selected file is an ArtCAM 
model. 
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In the File name field, the name of the selected file is displayed. 

4 Click Open to close the dialog and open the selected ArtCAM 
model file. 

The 2D View window is displayed by default. The white rectangle 
shown in the window is the model area. In this area you can see 
the vector artwork you will use as the foundation in the process 
of creating the Saw Mill sign. 

 

Preparing the vector artwork 
This section describes how to add to the vector artwork already 
included in the model so that you are ready to create the toolpaths 
needed to machine the Saw Mill sign. These vectors comprise 
offsets and text. 

 

Creating the offset vectors 
You are now ready to create some additional vectors using the 
artwork already in the model. This is needed when creating the 
toolpaths used to machine the Saw Mill sign. 

1 Press F3 to display the 3D View window.  

2 In the 3D View toolbar, click Toggle Vector Visibility . The 
vector artwork is displayed in the 3D View window. 

3 Select the grouped vectors that make up the Saw Mill vector 
text: 
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The characters that make up the Saw Mill vector text are shown 
in purple and surrounded by a bounding box, indicating that they 
are both grouped and selected: 

 
As the characters that make up the Saw Mill vector text are 
already grouped, you can create an offset vector around them all 
at once. 

4 In the Vector Creation toolbar, click Offset Vectors . This 
displays the Tool Settings: Offset Vectors. 

5 In the Offset Distance field, enter 6 mm (0.2 inches). 

6 In the Offset Direction area, select Outwards/right. This instructs 
ArtCAM to draw the offset vectors around the outside of the 
selected vector text. 

7 In the Offset Corners area, select Radiused. 

8 Deselect Delete original vectors. 

9 Select resulting offset. 
10 Click Offset to create the offset vectors. 
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The offset vectors are shown in magenta and surrounded by a 
bounding box; indicating they are ungrouped and selected: 

 
11 On the Tool Settings: Offset Vectors panel's header, click  to 

close the panel. 
 

Grouping the offset vectors 
The same toolpath settings will be applied to the offset vectors, so it 
is easier to group them together now and select them 
simultaneously, rather than selecting each of the offset vectors in 
turn when creating your toolpaths. 

1 In the 3D View window, click an empty area to deselect the offset 
vectors. The offset vectors are shown in black, indicating they 
are no longer selected. 
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2 Press and hold down the Shift key, and select the offset vectors, 
one by one, that surround the characters in the Saw Mill vector 
text. 

 
The offset vectors are shown in magenta and surrounded by a 
bounding box, indicating that they are ungrouped and selected. 

3 Press Ctrl+G to group the selected offset vectors. All of the offset 
vectors are shown in purple and surrounded by a bounding box, 
indicating that they are grouped and selected: 

 
 

Creating additional vector text 
You are now ready to create the vector text required to produce 
some additional text in the finished Saw Mill sign. 
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1 Press the F2 key to display the 2D View window. 

2 Click anywhere in the model area to deselect the grouped offset 
vectors. 

3 In the Design Tools toolbar, click Create Vector Text . This 
displays the Tool Settings: Text Tool panel. 

4 In the Tool Settings: Text Tool panel, click Align Left . This 
instructs ArtCAM to align the vector text to the left with a ragged 
right edge. 

5 Click the Font list, then select  Arial. 
6 If you are using metric measurements:  

a Click  in the Size area, and then select mm from the list. 

b In the Size field, enter 51 to set the size of the vector text. 

7 If you are using imperial measurements: 

a Click  in the Size area, and then select inches from the list. 

b In the Size field, enter 2 to set the size of the vector text. 

Use the default settings for the remaining options displayed on 
the Tool Settings panel. 

8 Click anywhere in the empty model area between the outermost 
vector and the vector that surrounds the offset vectors. 

9 Type Reception. 

10 In the Tool Settings: Text Tool panel, click Done. The vector text is 
created, the panel is hidden, and the Select tool is re-selected. 
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Repositioning the vector text 
You are now ready to reposition the Reception vector text so that it 
sits between the outermost vector and the vector that surrounds 
the grouped offset vectors. 

1 In the 2D View window, select the Reception vector text, hold 
down the Shift key, and then select the outermost vector: 

 
The outermost vector is shown in magenta; indicating that it is 
ungrouped. A bounding box surrounds this and the Reception 
vector text; indicating that they are both selected: 

 
2 In the Vector Editing toolbar, click and hold down the left mouse 

button when the cursor is on the Centre In Model  button. Its 
flyout toolset is displayed. 

3 Keep the mouse button held down and, move the cursor over the 

Centre Horizontally  button in the flyout toolset.  

4 Release the mouse button to align the centre of the outermost 
vector with the centre of the Reception vector text. 

5 In the 2D View window, click anywhere in the model area to 
deselect all vector artwork. 

6 Select the Reception vector text. 
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7 Use the  and  keys to adjust the vector text until it is 
positioned between the grouped offset vectors and the outermost 
vector: 

 
8 In the 2D View window, click anywhere in the empty model area 

to deselect the vector text.  
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Machining the Saw Mill sign 
This section demonstrates how to create the toolpaths needed to 
machine the Saw Mill sign. The settings within each toolpath are 
applied to different areas of the vector artwork. 

 

Clearing the area around the text 
You can now calculate the toolpath needed to clear the area around 
the Saw Mill vector text during the machining process. The toolpath 
settings are applied to the area between the grouped offset vectors 
surrounding the Saw Mill vector text and the vector surrounding the 
grouped offset vectors. You are machining the Saw Mill sign out of a 
sheet of material that is 25 mm (1 inch) thick. 

1 Press the F3 key to display the 3D View window. 

2 In the 3D View window, select the grouped offset vectors 
surrounding the Saw Mill vector text . 

3 Hold down the Shift key, and then select the vector that 
surrounds the grouped offset vectors . 

 
A bounding box surrounds the selected vectors. The offset 
vectors are shown in purple; indicating they are grouped. The 
vector that surrounds them is shown in magenta; indicating that 
it is ungrouped.  

4 In the Project panel, click the  Toolpaths item in the Project 
Tree to display the Toolpaths panel below the splitter bar. 
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5 In the 2D Toolpaths area of the Toolpaths panel, click Create Area 

Clearance Toolpath . The 2D Area Clearance panel is 
displayed. 

6 In the Finish Depth field, enter 8 mm (0.25 inches).  

7 Enter a Start Depth and Allowance of 0. 

8 Enter a Tolerance of 0.025 mm (0.001 inches). 

9 Click the Machine Safe Z control bar to display its settings, and 
then enter 25 mm (1 inch) in the Safe Z field and the Home 
Position's Z field. This controls the height at which the roughing 
tool makes rapid moves between toolpath segments. 

10 In the Tools List area, click Add. This displays the Tool Database. 

 
11 In the Wood or Plastic > Roughing and 2D Finishing tool group, 

double-click the End Mill 10 mm (End Mill 3/8 Inch) tool. This 
closes the Tool Database and displays the tool's description below 
the Tools List area. 

 If you are using ArtCAM Express, the Add button is 
unavailable after selecting the End Mill 10 mm (End Mill 3/8 
Inch) tool. This is because the Area Clearance toolpath is 
restricted to the use of one tool only in Express. 

 For illustration, the tool's Stepover has been increased to 8 
mm (0.25 inches). 
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In the Tool Clearance Strategy area, ensure the Raster option is 
selected. This strategy will be used along with a Raster Angle of 0 
in the toolpath. 

12 Deselect Add Ramping Moves. 

13 In the Material area, click Setup. This displays the Material Setup 
dialog. 

 
a Enter a Material Thickness of 25 mm (1 inch). 

b Set the Material Z Zero position to the top of the block. 

c Set the Model Position In Material relative to the top of the 
block. 

d Click OK to close the Material Setup dialog. 

14 In the 2D Area Clearance panel, click Calculate Now. The toolpath 
is named Area Clear by default and is displayed in the 3D View 
window: 
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15 On the 2D Area Clearance panel's header, click  to close the 
panel. 

 

Carving the text 
You are now ready to calculate the toolpath needed to carve the 
Saw Mill and Reception text during the machining process. The 
toolpath's settings are applied to the Saw Mill and Reception vector 
text. 

You can carve the Saw Mill and Reception vector text because it has 
been created using fonts compatible with V-bit carving. 

1 In the Project panel, click  beside the  Toolpaths item in the 
Project Tree to display the created toolpaths. 

2 Click  and  to the right of the  Area Clear toolpath group. 
In the 3D View window, the toolpath is hidden; making it easier 
to select the vector text you want to carve. 

3 In the 3D View window, click an empty area to deselect all vector 
artwork. 

4 Select the Saw Mill vector text, hold down the Shift key, and then 
select the Reception vector text:  

 
5 In the 2D Toolpaths area of the Toolpaths panel, click Create V-Bit 

Carving Toolpath . This displays the V-Bit Carving panel. 

6 In the V-Bit Carving panel: 

a Enter a Start Depth of 0. 
b Deselect Limit tool maximum depth. 
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c Enter a Tolerance of 0.025 mm (0.001 inches). 

d In the Carving Tool area, click the control bar to display the 
Tool Database. 

e In the Wood or Plastic > V-Carving tool group, double-click the 
V-Bit 32 mm 110 degree (V-Bit 1.25 Inch 110 degree) tool. 
This closes the Tool Database and displays the tool's 
description in the Carving Tool area. 

f Click Refresh. The Maximum Width and Maximum Depth values 
are displayed. 

g In the Carving Tool area, click the tool's description to display 
its machining parameters, and then enter 2 in the Tool Number 
field. 

 If you have a tool changer, this number should 
correspond with the position of the tool in the CNC 
machine. 

h Leave all other settings on the V-Bit Carving panel as the 
defaults and click Calculate Now to calculate the toolpath. The 
calculated toolpath is named V-Bit Carving toolpath by 
default, and is displayed in the 3D View window: 

 
7 On the V-Bit Carving panel's header, click  to close the panel. 

 

Cutting out the sign 
You can now calculate the toolpath needed to cut out the Saw Mill 
sign from the sheet of material during the machining process. The 
settings within the toolpath are applied to the outermost vector 
amongst the artwork shown in the 2D View window. 
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1 Press the F2 key to display the 2D View window. 

2 In the 2D View window, select the outermost vector. 

 
It is shown in magenta and surrounded by a bounding box, 
indicating that it is ungrouped and selected. 

3 In the 2D Toolpaths area of the Toolpaths panel, click Create 

Profile Toolpath  in the 2D Toolpaths area. This displays the 
Profiling panel. 

4 In the Profile list, select Outside. 

5 Enter: 

a Allowance — 0. 

b Start Depth — 0. 

c Finish Depth — 25 mm (1 inch). 

d Tolerance — 0.025 mm (0.001 inches). 

6 In the Profiling Tool area, click the control bar to display the Tool 
Database. 

a In the Wood or Plastic > Roughing and 2D Finishing tool group, 
double-click the End Mill 10 mm (End Mill 3/8 Inch) tool. This 
closes the Tool Database and displays the tool's description in 
the Profiling Tool area. 

b In the Profiling Tool area, click the tool's description to display 
its machining parameters, and ensure that the Tool Number 
field is set as 1. 

 If you have a tool changer, this number corresponds with 
the position of the tool in the CNC machine. The Profile 
toolpath uses the same tool as that used in the Area Clear 
toolpath; therefore you can set the tool number here so 
that it is identical in both of these toolpaths. 

7 Set the Cutting Direction to Climb. 

8 Select Add Lead In Moves. Its settings are displayed. 
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9 Select Circular Arc. This instructs the Profiling tool to lead into 
the vector's boundary in an arc motion. The arc lead move is 
positioned at the start node in the toolpath. The start point in the 
toolpath is equal to the start node in the selected vector. 

10 In the Distance (D) field, enter a value of 15. This sets the 
distance from the toolpath at which you want the Profiling tool to 
cut into and retract from the vector's boundary. 

11 In the Radius (R) field, enter a value of 15. This specifies the arc 
lead-in move's radius. 

12 Deselect Add Bridges. 

13 Deselect Add Ramping Moves. 

14 Click Calculate Now to calculate the toolpath. The calculated 
toolpath is named Profile by default, and is displayed in the 2D 
View window: 

 
15 On the Profiling panel's header, click  to close the panel. 

16 In the Project panel, click  and  to the right of the  V-Bit 
Carving toolpath in the Project Tree. This hides the toolpath in 
the 2D View and 3D View window. 
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17 Press the F3 key to display the 3D View window. The calculated 
Profile toolpath is shown as follows: 

 
 

Simulating the toolpaths 
You are now ready to simulate all three of the calculated toolpaths, 
render the resulting toolpath simulation, and then delete the surplus 
material from the simulation. 

1 In the Project panel, click the  Toolpaths item to display the 
Toolpaths panel below the splitter bar. 

2 In the Simulation area of the Toolpaths panel, click Simulate All 

Toolpaths . 
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In the 3D View window, the simulated Area Clear, V-Bit Carving 
and Profiling toolpaths are shown as follows: 

 

3 In the Project panel, click the  Simulation item to display the 
Simulation panel below the splitter bar. 

4 In the Rendering area of the Simulation panel: 

a Select Depth Colour, then click the brown swatch in the colour 
palette displayed below the 3D View window: 

 
b Click the Material list then select Light Oak (H). 
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c Click Apply. The toolpath simulation in the 3D View window is 
rendered as if the Saw Mill sign were machined and then 
painted: 

 

5 In the Simulation panel, click Delete Waste Material  to 
display the Tool Settings: Delete Waste Material panel. 

6 On the Tool Settings: Delete Waste Material panel, select Keep 
picked material. 

7 In the 3D View window, click an area of the toolpath simulation 
shaded in solid brown. The toolpath simulation looks as follows: 

 
8 Press the Esc key to close the Tool Settings: Delete Waste Material 

panel and re-select the Select tool. 
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Saving the toolpaths 
You are now ready to save the calculated toolpaths so you can 
machine the Saw Mill sign. 

You will save the toolpaths in separate files, grouping together 
those that use the same tool. Both the Area Clear and Profile 
toolpaths share the same tool number because they both use the 
End Mill 10 mm (End Mill 3/8 Inch) tool. 

1 In the Project panel, click  beside  Area Clear in the Project 
Tree, and then click  End Mill 10 mm (End Mill 3/8 Inch). Its 
name is highlighted, and its associated tools are displayed below 
the splitter bar. 

2 In the Toolpath Operations area of the Toolpaths panel, click Save 

Toolpaths . This displays the Save Toolpaths dialog. 

 
3 In the Calculated toolpaths window, select the Profile - End Mill 10 

mm (End Mill 3/8 Inch) toolpath. Its name is highlighted. 



 

56 • Getting Started in ArtCAM ArtCAM 2015 Getting Started  

4 Click  to move the toolpath to the Toolpaths to save window: 

 
5 Click the Machine file format list, then select the machine format 

in which you want to save your toolpath file. 

6 In the File name field, type Area_Clear_Profile, and then click 
Save to save the toolpath file to the Spool Directory. 

7 Click  to return the toolpaths in the Toolpaths to save window 
to the Calculated toolpaths window. 

8 In the Calculated toolpaths window, ensure the V-Bit Carving - V-
Bit 32 mm 100 degree (V-Bit 1.25 Inch 110 degree) toolpath is 
selected by clicking its name. Its name is highlighted. 
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9 Click  to move the toolpath to the Toolpaths to save window: 

 
10 In the File name field, type Carving, and then click Save to save 

the toolpath file to the Spool Directory. 

11 Click Cancel to close the Save Toolpaths dialog. 

You are now ready to send the toolpath files to your CNC machine 
to manufacture the Saw Mill sign. 
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Tutorial - Lizard 
This tutorial demonstrates how to machine a piece of relief clipart. 
You will import a lizard relief from ArtCAM's Relief Clipart Library, 
and then create the 3D toolpaths needed to machine the lizard 
relief. 

The stages covered by this tutorial are: 

 Preparing the model (see page 59). 

 Importing the relief clipart (see page 60). 

 Calculating the toolpaths (see page 64). 

 Simulating the toolpaths (see page 69). 

 Saving the toolpaths (see page 71). 

At the end of this tutorial, you will have created all of the toolpath 
files needed to machine a lizard relief using ArtCAM. 
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Preparing the model 
Begin by creating a new ArtCAM model. 

1 In the Start panel, click  New Model. The Size For New Model 
dialog is displayed. 

 
2 Fill in the dialog as follows: 

a Height (Y) — 300. 

b Width (X) — 500. 

c Units — mm. 

d Resolution — Around 1500 x 900 points. 

e Select the bottom left-hand corner as the job origin. 

3 Click OK to close the dialog and create a model according to 
these dimensions. 

In the 2D View window, the white model area represents the 
block of material when viewed down the Z-axis.  
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Importing the relief clipart 
You are now ready to import a piece of relief clipart into the model. 

1 In the Relief Creation toolbar, click Relief Clipart Library . The 
Relief Clipart Library panel is displayed. 

2 In the Relief Clipart Library panel, click the Choose Library list, 
then select Animals to display thumbnails of its associated 
selection of relief clipart. 

3 Click the Lizard thumbnail to import the lizard relief clipart. 

 
The Tool Settings: Transform panel is displayed, and the lizard 
relief clipart's outline is shown in the 2D View window:  
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The lizard relief clipart's outline is purple and surrounded by a 
bounding box; indicating it is grouped and selected. You can also 
see: 

 the blue transform origin within the outline; 

 the green rotation handle within the outline, which you can 
use to rotate the relief clipart; 

 red resizing handles on each edge of the bounding box; and  

 two red shearing handles outside the left and bottom edges of 
the bounding box.  

4 Press F3 to display the 3D View window. 

5 In the 3D View toolbar, click Toggle Vector Visibility .  

In the 3D View window, the lizard preview relief and its outline 
are shown: 

 
The lizard review relief's outline is purple and surrounded by a 
bounding box; indicating it is grouped and selected. You can also 
see: 

 a transform origin  within the outline; 

 a rotation handle  within the outline, which you can use to 
rotate the relief clipart; 

 resizing handles  on each edge of the bounding box; and  

 two shearing handles  adjacent to the left and bottom edges 
of the bounding box.  

6 Press F3 to display the 3D View window. 
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7 On the Relief Clipart Library panel's header, click  to close the 
panel. 

8 In the Tool Settings: Transform panel, click Relief Clipart Paste 

Options  to display the paste options. 

9 In the Paste Combine Mode area:  

a Select Add. 

b Select Paste outline vector. 
10 Click Paste to paste the lizard relief clipart into the relief. The 

lizard relief clipart's outline is also pasted into the model area as 
a vector boundary. It is black and deselected. 

 

 
11 Press F2 to display the 2D View window. 
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12 In the 2D View toolbar, click Toggle Relief Preview  to display 
a greyscale image of the relief in the 2D View window: 

 

13 Click Toggle Relief Preview  again to hide the greyscale 
image of the relief. 
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Calculating the toolpaths 
You are now ready to create and calculate two toolpaths. The first is 
used to machine the whole of the relief, and the second to machine 
only the area of the relief within the lizard relief clipart's vector 
boundary.  

1 Press F3 to display the 3D View window. 

2 In the Project panel, select  Toolpaths in the Project Tree. This 
displays the Toolpaths panel below the splitter bar. 

3 In the 3D Toolpaths area of the Toolpaths panel, click Create 

Machine Relief Toolpath  to display the Machine Relief panel. 

a In the Area to Machine area, select Whole Relief. 
b Click the control bar in the Finishing Options area to display 

the Tool Database. 

c In the Wood or Plastic > 3D Finishing tool group, double-click 
the Ball Nose 3 mm tool: 

 
The Tool Database closes and the tool's description is 
displayed on the control bar. 

d Click the Tool clearance strategy list then select Raster 
(Classic). 

e Enter an Angle of 0. 

f Enter a Tolerance of 0.01. 
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g Enter an Allowance of 0.1. 

h Click the Multiple Z Passes control bar to display its settings. 

i Select Do Multiple Z Passes. 

j In the Start Z field, enter -3. 

 This value is equal to the Max Z height of the material 
block less the Stepdown associated with your selected 
tool. 

The number of passes made between the Z height of the first 
and last pass is decided by the Stepdown associated with your 
selected tool. 

 If you cannot see the Stepdown associated with your 
selected tool, click the control bar displaying the tool's 
description in the Finishing Tool area to show its 
parameters. 

k In the Finish Z field, enter -45.  

l In the Options area, click the second control bar to display the 
Safe Z field and the Home Position's X, Y and Z fields. 

m In the Safe Z and Home Position's Z field, enter 10. 

n Click the control bar to hide the Safe Z field and the Home 
Position's X, Y and Z fields. 

o In the Name field, enter Machine Relief. 
p Click Calculate Now to calculate the toolpath. 

In the 3D View window, the calculated Machine Relief toolpath 
is shown as follows: 
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 You can use the Zoom  button in the 3D View toolbar 
to view the machining passes in more detail. After clicking 
the button, position the magnifying cursor over the area of 
the toolpath on which you want to focus, click and drag to 
create a bounding box surrounding the area of the toolpath, 
and then release the mouse button to zoom on the area 
within the bounding box. 

4 In the Project panel, click  beside the  Toolpaths item in the 
Project Tree. The calculated  Machine Relief toolpath is now 
shown. 

5 In the Project panel, click the light bulb  icon beside the 
Machine Relief toolpath in the Project Tree. The Machine Relief 
toolpath is hidden in the 3D View window. 

6 In the 3D View window, select the lizard relief clipart's vector 
boundary.  
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The vector is shown in purple and surrounded by a bounding 
box; indicating it is both grouped and selected. 

 
7 On the Machine Relief panel: 

a Click the Area to Machine list then select Selected Vectors. 

b Select Inside Vector. 
c In the Finishing Options area, click the control bar to display 

the parameters associated with the currently selected tool. 

d Click Select to display the Tool Database. 

e In the Wood or Plastic > 3D Finishing tool group, double-click 
the Ball Nose 1.5 mm tool. The Tool Database closes and the 
tool's description is displayed on the control bar. 

f Select Raster (Classic). 
g Enter an Angle of 0. 

h Enter a Tolerance of 0.01. 

i Enter an Allowance of 0.1. 

j Select Do Multiple Z Passes. 

k In the Start Z field, enter -1.5. 

 This value is equal to the Max Z height of the material 
block less the Stepdown associated with your selected 
tool. 

l In the Finish Z field, enter -45. 
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m In the Options area, click the second control bar to display the 
Safe Z field and the Home Position's X, Y and Z fields. 

n In the Safe Z and Home Position's Z field, enter 10. 

o Click the control bar to hide the Safe Z field and the Home 
Position's X, Y and Z fields.  

p In the Name field, enter Machine Relief 1. 

q Click Calculate Now to calculate the toolpath. 

In the 3D View window, the calculated Machine Relief 1 
toolpath is shown as follows: 

 

 Rapid moves within the toolpath are shown in blue, while 
plunge moves are shown in cyan. You can toggle the 
display of these moves in the 3D View window using the 
Toolpaths > Toolpath Drawing > Draw Rapid and Plunge Moves 
option from the Main Menu bar. 

On the Project panel, the calculated  Machine Relief 1 toolpath 
is listed below the  Machine Relief toolpath in the Project Tree. 

8 Click  on the Machine Relief panel's header to close it. 
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Simulating the toolpaths 
You are now ready to simulate both of the calculated toolpaths, and 
then render the resulting toolpath simulation using a shading set. 

1 In the Project panel, click the  Toolpaths item in the Project 
Tree to display the Toolpaths panel below the splitter bar. 

2 In the Simulation area of the Toolpaths panel, click Simulate All 

Toolpaths . 

In the 3D View window, the simulated Machine Relief and 
Machine Relief 1 toolpaths are shown as follows: 

 

3 In the 3D View toolbar, click Origin  to hide the origin 
gnomon in the 3D View window. 

4 In the Project panel, select the  Simulation item in the Project 
Tree to display the Simulation panel below the splitter bar. 

5 In the Rendering area of the Simulation panel, click:  

a Click the Material list, then select Platinum. 
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b Click Apply. The toolpath simulation in the 3D View window is 
rendered as if the lizard were cast in platinum: 
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Saving the toolpaths 
You are now ready to save your calculated toolpaths so that you can 
machine the lizard relief. Each of the toolpaths will be saved as 
separate files.  

1 In the Project panel, select the  Machine Relief toolpath in the 
Project Tree to display its panel below the splitter bar. 

2 Click Save Toolpaths . This displays the Save Toolpaths 
dialog: 

 
3 Ensure that the Machine Relief - Ball Nose 3 mm Finishing 

toolpath is shown in the Toolpaths to save window. 

4 Click the Machine file format list, then select the machine format 
in which you want to save your toolpath file. 

5 In the File name field, enter Machine_Whole_Relief, and then click 
Save to save the toolpath file to the Spool Directory. 

6 Click  to move the Machine Relief - Ball Nose 3 mm Finishing 
toolpath to the Calculated toolpaths window. 

7 Select the Machine Relief 1 - Ball Nose 1.5 mm Finishing toolpath 
in the Calculated toolpaths window. 
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8 Click  to move the toolpath to the Toolpaths to save window: 

 
9 In the File name field, enter Machine_Lizard_Only, and then click 

Save to save the toolpath file to the Spool Directory. 

10 Click Cancel to close the Save Toolpaths dialog. 

You are now ready to send the toolpath files to your CNC machine 
to manufacture the lizard. 
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This section describes the various shortcuts which are available to 
help you work as efficiently as possible. Some are available with no 
tool selected, whereas others are only active when you are working 
with a specific tool. You can also customise the shortcuts or assign 
your own shortcuts to actions if you prefer.  

 General shortcuts (see page 74) 

 Vectors (see page 77) 

 Bitmaps (see page 78) 

 Reliefs (see page 79) 

 Tool specific shortcuts (see page 80) 

 Using the mouse (see page 85) 

 

ArtCAM Keyboard 
shortcuts 



 

74 • ArtCAM Keyboard shortcuts ArtCAM 2015 Getting Started  

General shortcuts 
These shortcuts can be used with no specific tool selected. 

Models 
The following shortcuts can be used when working with models: 

 
Function Shortcut 
Open model. Ctrl+O 

Create new model. Ctrl+N 

Save model. Ctrl+S 

Print model. Ctrl+P 

Toggle Notes visibility. Ctrl+N 

 

View control 
The following shortcuts can be used to adjust the ArtCAM layout and 
manipulate the view: 

 
Function Shortcut 
Display the Reference Help. F1 

Display 2D View window. F2 

Display 3D View window. F3 

Toggle Project panel visibility. F4 

Toggle Tool Settings panel visibility. F6 

Preview currently active relief layer 
in 2D View. 

 If you are working in ArtCAM 
Insignia, a preview of the relief 
is displayed. 

F10 

Toggle visibility of cursor 
information. 

Alt+C 

Toggle visibility of currently active 
bitmap layer. 

Alt+B 
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Create greyscale from composite 
relief. 

 If you are working in ArtCAM 
Insignia, you cannot create a 
greyscale from the relief. 

Alt+G 

View the model from the Top. (3D 
View window only.) 

Ctrl+Num 5 

View the model from the Bottom. 
(3D View window only.) 

Ctrl+Num 0 

View the model from the Left. (3D 
View window only.) 

Ctrl+Num 4 

View the model from the Right. (3D 
View window only.) 

Ctrl+Num 6 

View the model from the Front. (3D 
View window only.) 

Ctrl+Num 2 

View the model from the Back. (3D 
View window only.) 

Ctrl+Num 8 

Switch to Iso 1 view. (3D View 
window only.) 

Ctrl+Num 1 

Switch to Iso 2 view. (3D View 
window only.) 

Ctrl+Num 3 

Switch to Iso 3 view. (3D View 
window only.) 

Ctrl+Num 9 

Switch to Iso 4 view. (3D View 
window only.) 

Ctrl+Num 7 

 

Editing 
The following shortcuts can be used when editing vectors or relief 
clipart: 

 
Function Shortcut 
Select all objects (vectors and relief 
clipart). 

Ctrl+A 

Cut to ArtCAM clipboard. Ctrl+X 

Copy to ArtCAM clipboard. Ctrl+C 

Paste from ArtCAM clipboard. Ctrl+Y 

Undo. Ctrl+Z 
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Redo. Ctrl+Y 

Delete selected objects. Delete 

Use the Node Editing tool. N 

Use the Transform tool. T 

Use the Envelope Distortion tool. Ctrl+E 

Nudge selected object up. 
 

Nudge selected object down. 
 

Nudge selected object right. 
 

Nudge selected object left. 
 

Open the Nudge Distance dialog. Alt+Arrow key 

Create copy of nudged object in its 
original position. 

Ctrl+Alt+Arrow key 

Measure tool. M 

Centre in model. F9 

Align vertical centre. 
Shift+  

Align horizontal centre. 
Shift+  

Align left. 
Ctrl+  

Align right. 
Ctrl+  

Align top. 
Ctrl+  

Align bottom. 
Ctrl+  

Exit current mode and return to 
Select tool. 

Esc 

Display the Shape Editor. F12 
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Vectors 
The following shortcuts can be used when you are working with 
vectors: 

 
Function Shortcut 
Create vector and continue 
drawing. 

Enter or Space Bar 

Keep aspect ratio (Create 
Rectangle only). 

Shift 

Temporarily disable snapping on 
a vector layer. 

Shift 

Display the Tool Settings panel 
for the selected vector shape. 

E 

Display the Vector Clipping panel. Ctrl+Alt+Shift+C 

Display the Vector Slice panel. Ctrl+Alt+Shift+V 

Group selected vectors. Ctrl+G 

Ungroup selected vectors. Ctrl+U 

Reset the relief inside a selected 
vector 

Ctrl+0 

Reset the relief outside a 
selected vector 

Ctrl+Alt+0 
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Bitmaps 
The following shortcuts can be used when working with bitmap 
artwork: 

 
Function Shortcut 
Toggle linking between primary 
and secondary colours. 

Ctrl+L 

Link all colours (except Primary 
and Secondary). 

Ctrl+K 

Unlink all colours. Ctrl+R 
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Reliefs 
The following shortcuts can be used when you are working with 
reliefs or relief clipart: 

 
Function Shortcut 
Reset the currently active relief 
layer. 

Shift+Delete 

Copy relief. Ctrl+Shift+C 

Display the Offset Relief dialog. Ctrl+Alt+Shift+O 

Use the Cookie Cutter tool. Ctrl+T 

Create a copy using the Relief 
Cookie Cutter tool. 

Ctrl+Shift+T 

Paste relief clipart into the active 
relief layer. 

Enter 

Reset the relief inside a selected 
vector 

Ctrl+0 

Reset the relief outside a 
selected vector 

Ctrl+Alt+0 
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Tool specific shortcuts 
Some shortcuts are only available when you have a specific tool 
selected. 

 Transform tool (see page 81) 

 Node editor (see page 82) 

 Text tool (see page 83) 
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Transform tool 
The following shortcuts can be used when you are using the 
Transform tool to manipulate vectors or relief clipart. 

Scale and Size shortcuts: 
Function Shortcut 
Leave behind a copy of the selected 
object in its original position. 

Ctrl+drag 

Resize an object relative to its 
Transform Origin. 

Alt+drag 

Temporarily unlink the dimensions in 
the Scale and Size area. 

Shift+drag 

 

Move shortcuts: 
Function Shortcut 
Leave a copy of the selected object 
in its original position. 

Ctrl+drag 

Restrict movement to the X and Y 
axes. 

Alt+drag 

Temporarily disable snapping. Shift+drag 

 

Rotate shortcuts: 
Function Shortcut 
Leave behind a copy of the selected 
object in its original position.  

Ctrl+drag 

Rotate object in 15 degree 
increments. 

Alt+drag 

Temporarily disable snapping. Shift+drag 

 

Shear shortcuts: 
Function Shortcut 
Leave a copy of the selected object 
in its original position. 

Ctrl+drag 

Temporarily disable snapping. Shift+drag 
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Node Editing 
The following shortcuts can be used when you are in Node Editing 
mode: 

 
Function Shortcut 
Enter Node Editing mode. N 

Convert span (linear or bezier) 
to arc. 

A 

Convert span (linear or arc) to 
Bezier. 

B 

Convert span (bezier or arc) to 
line. 

L 

Cut span. C 

Remove span. R 

Insert node. I 

Insert start node or change node 
to start node. 

P 

Toggle smoothing on node. S 

Delete node. D 

Align selected nodes in X-axis. X 

Align selected nodes in Y-axis. Y 

Nudge selected node up. 
 

Nudge selected node down. 
 

Nudge selected node right. 
 

Nudge selected node left. 
 

Open the Nudge Distance dialog. Alt+Arrow key 
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Text tool 
The following shortcuts can be used when using the Text tool: 

 
Function Shortcut 
Move a word. Ctrl+drag 

Move a character. Alt+drag 

Start a new line of text. Enter 

Delete a character. Backspace 
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Polyline tool 
The following shortcuts can be used when using the Polyline tool: 

 
Function Shortcut 
Toggle Draw smooth polylines. S 

Toggle Add to existing line. E 

Temporarily disable snapping. Shift+drag 

Constrain angle of linear span 
between nodes to 15 degree 
increments. 

Ctrl+drag 

Close polyline to create polygon 
and continue drawing. 

Tab 

Create polyline and continue 
drawing. 

Space Bar 
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The way in which your mouse can be used in ArtCAM often changes 
according to which design window is displayed and the particular 
aspect of the model on which you are working. If you own a mouse 
with a wheel this increases the range of options available to you. 

You can click buttons or objects with or without keyboard modifier 
keys (Alt, Shift, Ctrl) to alter the way you can create, select, move, 
edit or view models on the screen. The following terms are used in 
the documentation: 

 Click — Press and release the left mouse button. 

 Double-click — Rapidly click the left mouse button twice. 

 Drag — Hold down the left mouse button and move the mouse 
while holding the button down. 

 Move — Move the mouse without selecting any of the mouse 
buttons. 

When other mouse buttons are to be used, the required button is 
specified; for example  
 Middle-click  
 Right-click 

The cursor that is displayed when you use the mouse reflects the 
operation that is being carried out. 

 

Using the mouse 
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Common mouse controls 
2D View 
You can use the mouse to manipulate the 2D View in the following 
ways: 

 
ArtCAM Function Mouse Action 
Magnify view by 
50%. 

 
Reduce view by 
50%. 

 
Zoom in. 

 
Zoom out. 

 

 

3D View 
You can use the mouse to manipulate the 3D View in the following 
ways: 

 
ArtCAM Function Mouse Action 
Rotate view. 

 
Zoom. 

 
Pan view. 

 
Zoom in. 

 
Zoom out. 
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Vectors 
You can use the mouse relative to vector artwork in the following 
ways: 

 
ArtCAM Function Mouse Action 
Select vector (also 
select node in node 
editing mode).  

Select multiple 
vectors. 

 
Copy vector. 

 on selected vector. 

Display context 
menu. 

 on selected vector. 

Display Shape Editor. 

 on selected vector. 

 

Bitmaps 
You can use the mouse relative to bitmap images shown in the 2D 
View in the following ways: 

 
ArtCAM Function Mouse Action 
Select primary 
colour. 

 on colour swatch in colour palette. 

Select secondary 
colour. 

 on colour swatch in colour palette. 

Link colour to 
primary colour. 

 on colour swatch in colour palette. 

Display Shape Editor. 

 on colour swatch in colour palette, 2D 
View or 3D View. 
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Toolpaths 
You can use the mouse relative to toolpaths in the following ways: 

 
ArtCAM Function Mouse Action 
Edit toolpath. 

 on 2D toolpath preview or toolpath 
name. 
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